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PDF/A: The Future of Electronic Document Archival

Many years ago, the federal judiciary embraced the PDF standard for documents filed in its
Case Management/Electronic Case Files System (“CM/ECF”). Since then, the PDF standard has
evolved to include new features, some of which have raised concerns about the security and
long-term archival storage of documents. PDF/A, which is a subset of the PDF standard,
addresses those concerns.

A PDF/A document is a self-contained file; all of the information needed to view the document
is embedded within it. For little or no cost, this format allows a document to be read without
dependency on any specific external software program. Additionally, it provides for long term
integrity of the document and a flexible structure by which to view it as technology advances.

PDF/A format will become mandatory for all documents electronically filed in the Western
District of North Carolina. At this point, a specific date has not been determined. In its current
configuration, CM/ECF accepts both PDF and PDF/A documents. Thus, law firms may want to
keep the PDF/A standard in mind when contemplating future upgrades to your hardware and
software applications.

For more information of PDF/A, please visit the following websites:

A white paper on PDF/A:
http://www.pdf-tools.com/public/downloads/whitepapers/whitepaper-pdfa.pdf

A PDF/A tutorial:
http://www.acrobatusers.com/tutorials/long-term-pdf-storage

A list of PDF/A compliant products:
http://www.pdfa.org/doku.php?id=pdfa:en:products
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Creating PDF/A Documents

More than ninety commercial products can create PDF/A documents (many are listed at
http://www.pdfa.org/doku.php?id=pdfa:en:products:create and
http://www.pdfa.org/doku.php?id=pdfa:en:products:convertpdf). The Court does not
recommend any particular products. PDF/A documents can be created by most word processor
programs. The necessary settings for some popular products are below:

OpenOffice settings for PDF/A

From the File menu, select “Export as PDF”.

Z PDF Options
General |nitial View | User Interface | Links | Security |
Range
@ All
O pages —
(3 Selection
Images

() Lossless compression

(% |PEG compression

Quality E

[[] Reduce image resolution

4

General
[[] Tagged PDF
[] Create POF form
submit format FDF b
[] Export bookmarks
[[] Export notes
[[] Export automatically inserted blank pages

’ Export ” Cancel H Help ]

Check the box labeled “PDF/A-1" and click the Export button.
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Word 2007 (or older) with the PDFMaker plugin

In Word 2007, click the Acrobat tab and “Preferences”:

—/ Home Insert Page Layout References Mailings Review View Menus Acrobat

=

= |
Create Preferences Create and Mail Create and Send  Acrobat
PDF Attach to Email Merge For Review Comments =
Create Adobe PDF | Create and Email Review And Comment

In older versions of Word, select “Change Conversion Settings” from the Adobe PDF menu:

3} Document1 - Microsoft Word

File Edit Yiew Insert “ormat  Tools Table ‘Window Help | Adobe POF | Acrobat Zomments
b Em &Y @ - |6 O] 100%

) £

o
g

The “Acrobat PDFMaker” window is displayed.
e inthe “Conversion Settings” drop-down, select PDF/A-1b:2005 (RGB)
e check the box for Create PDF/A-1a:2005 compliant file
e click the OK button.

Convert to Adobe PDF

Convert to Adobe PDF and Email

o Oy N

Corvett to Adobe PDF and Send For Review =

Change Conwversion Settings |F

74 Mail Merge ko Adcbe PDF

- Aorobat PDFMaker x|

Setlings |SEcurily| ‘word I Bnnkmarksl
- BOER aker S eting:
Canversion Settings: [FDF/A- 16 2005 [FIGE) - |

Usze these settings to create Adobe POF documents that are to be checked or must =
conform to POFA4-1b, an 150 standard for the long-teim preservation [aichival) of  _x

¥ “iew Adobe PDF result
¥ Prompt for Adabe POF file name

¥ Convert Document Information Fanezd Seiligs

I ¥ Create PDF/4-1a2005 compliant ‘il I

~ Application Settings
[T attach source file

¥ Creats Bookmarks

¥ Add Links

¥ Enable &ccessibiity and Beflow with tagged Adobe PDF

® @ 1987-2008 Adobe Sysems Incorporated and its licensars. Al rights reserved.
r“ Adobe, the Adobe logo, Acrobat, the Adobe PDF logo, PostScript, and Reader are
either registered trademalks or trademarks of Adobe Systems |ncorporated in the
Adobe United States and/or other countries.

Restore Defaults | ak. I Cancel | Help |

Thereafter, any PDF you create with Word will be in PDF/A format.
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Word 2007 without the PDFMaker plugin
Click “Save As” and select “PDF or XPS”:

= ] ’
j S Save a copy of the document I

Word Drocument
Save the file as a Word Document,

=
|/ Gpen
| W d Word Template
j Conyert [==| Save the document as a template that can
L be used to format future documents.
@ ‘Waord 97-2003 Document
H ——=| Save a copy of the document that is fully

save
compatible with Word 97-2003,

e == =
!.ﬂ SvEAs * | T AdobePDF

~u =
{ 7 Openfrom Office™s [E" OpenDocument Text
| Bz =| Save the document in the Open Document
il Format, |
H Save to Office Live PDF or XPS |
Publish a copy of the documentasaPDF ar |||
| XPS file.
@ Erint Other Formats
| Open the Save As dialog box to select from
| Fﬁ Prepare ¥ all possible file types.
!
@ Send 13
| .;L: Publish 3
L
| Close

= — |
ﬁ ‘Word Options ||X Exit Word |‘

The “Publish As” window is displayed. Click the Options button; in the Options window, click the
checkbox for “ISO 19005-1 Compliant (PDF/A)”:
I
Insert Page Layout References Mailings R

Page range
'1'"""g"""""'."'? @ al RN =
) Current page

) Page(s) Frome [ Toi [y ]7”2'
: Fublish what e
Saveim |ID My Documents @ Bl
B My Recent | [C2CCwin Bocument shaving markur
Documents | |25 Corel User Files
(@ pesktan () <ropper Captures
| |)Diagnostic Tool For the Micrasoft wM
|D B"V > |EDownloaded Program Updates
—OEE | [ bownloads
My :
L] Clpitar @Flddlerz b
| My Mbwork |HTML ) Document structure tags For accessibility
b Places ety trusic i
PDF options
Iﬂmy Pictures
(St chapas | [Flis5 150051 complant (POFjA): |
[ ray videas et when Fonts may
20y Virtual Machines
ICnghbwsstr default
L T | Bl
File name: 1nternet hyperlinks v
Sawe as type: ‘PDF v ‘
Open file after publishing
Optimize for:  (5) Standard (publishing onine and printing)
() Minirnu size: ¢publishing online)

Click the OK button to return to the “Publish As” window. Click the Publish button to save the
PDF/A file.
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Word 2008 for Mac

Microsoft Word 2008 for Mac cannot directly create PDF/A documents. However, it can create
PDF documents which can be converted to PDF/A using Acrobat; for one method see
Converting a PDF document to PDF/A with Acrobat. Alternately, you can install and use
OpenOffice (http://www.openoffice.org ), which is available for free; see OpenOffice settings
for PDF/A.

Word 2010

Click “File, Save & Send” and select “Create PDF/XPS”:

Home  Insert  Pagelayout  Refersnces  Mailings  Review  View  Menus
[ save
Save & Send Create a PDF/XPS Document

B saveas

l'j Save this document in a fixed format,
5 open |= %endUsing E-mail Document looks the same on most computers
5 Close Preserves fonts, fnrmat.tmg, and images

o Saveto Web Content cannot be easily changed
Info Free viewers are available on the Web

Recant " Save to SharePoint ‘.;
! " Create
Ni
ew @ Publish as Blog Post POFS [

pant File Types

save & send H Change File Type

Help =
I Q Create PDF/XPS Document {

-1 Options

B3 Bt

For either version of word, the “Publish As” window is displayed. Click the Options button; in
the Options window, click the checkbox for “ISO 19005-1 Compliant (PDF/A)":

Insert  Pagelayout  References  Mailings  Re
Fags range
S g ------ R ) S |
. - . o @ . -
‘ ) Current page
or e ——
B . Publish whak v
Sevein: | (L) My Documents & bRl J @ | K E-
(CCCWin
e () Corel User Fil
D Corel User Fles Include non-printing information
(@ Deskiap () Cropper Caphures
() Diagostic Tool For the Micrasoft ¥M
= My () Downloaded Program Updates
D t:
oM | Sipownioads
My e ; ;
] S gFudd\erz oEUmENt prope
My Netwark (EHTHL Document structure tags For accessibility
L it Yy Music
(Z)y Pictures e
By shapes 1[50 15005-1 compliant (FDF/A) I
™ty videos Bitmap text wihen font eI
‘QMY Virtual Machines =
(Inghhwstr.default
&l J &
File name: |rternet hyperiinks ~|
Save astype: |ppr 8
Gpen file after publishing
Optimize for: (%) Standard (publishing orine and printing)
() Minimum size (publishing online)

Click the OK button to return to the “Publish As” window. Click the Publish button to save the
PDF/A file.
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Corel WordPerfect X5 settings for PDF/A

[WordPerfect X4 must have the WordPerfect Office X4 Hot Fix 2 installed. If you are using an
older version of WordPerfect, you must produce a PDF and then convert it to PDF/A]

From the File menu, select Publish to PDF, and click the Settings button:

Publish to PDF k3

Save jn: . () My Documents | OFem
: IEcowin C)Wrking Fies
E} |1 Corel User Files " 4th - 02-49
My Recent I,"_‘| Cropper Caphures 1 4th - 08-436
Documents I-ﬂoiaqnosxic Tool Fer the Mcrosaft v " 6th - 07178
| ) Downloaded Program Lipdates = 10th - 05-15¢
E |E2 Downloads 10t - 0610
. -
Desktop (Fiddlerz = 0721desa
LIHTML L 0T40desal
= | 1My Music = 2000 NGS QU
1,
___j My Bictures 152050253
| |Ed My shapes = |6666design
Dacunents | .
My Docum 1y videos =L 20175 6-11-1
— |iMy virtual Machines Hlovi5136
Idngﬂmr.defaﬂ: T 0915138-PDF
] | Spamassassin T ACOZLIECFe
My Computer II‘_'| =
[# ¥
My Nebwark | POF Style: [ cusstom {Current settings not saved) ~ Canicel i
Places '
[[] Ops=n POF Aifber Saving Sattings... i

Select PDF/A-1a from the “Compatibility” drop-down and click OK:

General | Objects | Document | Advanced | Secuiy |

File name: C:\Documents and Settings\WONHINKC\My Dacuments\D acument!.pc

Export range
(®) Full document ) Current Page
elect O Pages: |
Compatibity: | PDF/A-1a v

Actobat 3 (PDF 1.2)
Author: Aciobat 4 (PDF 1.3)

Acrobat 5 (PDF 1.4)
Keywaords:  |PDF/8-1b

PDF 3{2|B: | |

Lo J[ concel J[ tep |

Click OK to return to the “Publish to PDF” screen to complete document production. The
compatibility setting will remain set to PDF/A until you change it.
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Creating PDF/A document with Acrobat
Converting a PDF document to PDF/A with Acrobat 9 Professional

Open the PDF document, and select “Preflight” from the Advanced menu:

Preflight [

7. 'ﬁj‘% Profiles Results *Skandards Ciptions ™

Show al = [® ® &

P Create PDF layers

¥ pigital printing and online publishing
P PDF analysis

P PDF fixups

(B & Convert to POF{&-1b (sRGE)

}'.\[_[,9 Remoyve POEA information

,'@_l_,f verify compliance with PDFfA-1a

4® J; Werify compliance with POFfA-1b

P PDF/E compliance

P PDF/X compliance

¥ Prepress +

w Further Cptiors B fnaly: J 1B analyze and fix

checks for visible layers only
I | |
; |+
2 | |

Under “PDF/A compliance”, select the “Convert to PDF/A-1a” or “Convert to PDF/A-1b” option
to create the PDF/A document.

Creating a PDF/A document with the “print” method

Many web sites, such as uscourts.gov, make PDF forms (in standard PDF format) available for
filling out in a browser. If you have Acrobat 9 Professional, you can save such a form, then
convert it to PDF/A. However, if you have Acrobat 9 Standard instead of Professional, you must
“print” it from the browser, with “Adobe PDF” selected as the “printer”.

The print option is also available in word processors, in Acrobat 9 Standard and Professional,
and in other contexts. Note that it will create a file in PDF/A-1b format that is acceptable for
CM/ECF submission, but hyperlinks (if any) may not work - so use it only if you have no other
option for creating PDF/A.
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Open the PDF in the browser or other application. Select the application’s Print option (often
on the File menu). In the list of printers, select “Adobe PDF”:

= = [1]ir iik ) € | @@ (=] Q- A - H @I E
E::J Please fill aut the Fallawing Farm. E

1. If anv of the debtor’s securities are registered under Section 12 of the Secunities Exchange Act of 1934, the
SEC _EI

Print: -
| - dition on
e o ror —
— Shatil il l’\§ Fomments and Forms:
Type:  Adobe PDF Converter |D0cument and Markups bt
Prink Range Preview: Composite
[OF1] 2 85 3 —
D Current view =

X SATHIED
et
olders:

Page Handling
Copies: 1 ]| Collate 1

Page Scaling: |Fit to Printable Area b

[#] Auto-Rotate and Center

[l choose paper source by PDF page size

e

. y Units: Inches Zoom ; 100%
[CIerint ta fil
rint to file

[CIPrint color as black

Prinking Tips

11

i Canicel

Click the Properties button. On the “Adobe PDF Settings” tab, select one of the PDF/A1b:2005

options from the Default Settings drop-down:

= IAdobePDEDocUmEntIProperties ?)x]
Layout | Paper/Qualiy | L2 Adobe POF Settings

Adobe PDF Corwersion Settings

Uze these settings to create Adobe PDF documents that are to be checked or must confarm

Q ta PDF/A-1b, an 150 standard for the long-term preservation [archival) of electonic
daocuments. For mare information on creating PDF/A compliant POF documents, pleaze refer
to the Acrobat User Guide. Created PDF documents can be opened with Acrobat and Adobe
Fieader 5.0 and later.

Default Settings: |[ZIZ0 (RGE] [~

Adobe PDF Security: | None D

Adobe PDF Output Folder | Prompt for Adobe POF flename [~
Adobe PDF Page Size: | Latter D

Wiew Adobe PDF results
Add docurment information

Fiely on system fonts only; do not use document fonts
Delete log files for successful jobs

[ Ask. ta replace existing PDF file

Ok ] ’ Cancel
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Creating PDF/A from a scanned document

You may be able to use the scanner’s software to create a PDF/A document directly -check the
vendor’s documentation. If not, use one of the methods below.

If the scanner is connected directly to your computer

If you are using Adobe Acrobat, from the File menu select “Create PDF”, “From Scanner”,
“Configure Presets”:
Adobe Acrobat

58 Edit Wiews Document Comments Forms  Tools  Advanced  Window  Help

| Open... Chrl4+-0 w7 Courier
Organizer L
Create PDF Portfolio s - |_|Y I = [ BN (i i}
Miadify PDF Portfolio r
Y Create POE | (57 From Eile.. Ctrln
,ﬁll Combine ¥ & From Scanner Black & White Document
,'_1] ol batate ’- ir.‘_a From ieb Page... Shift+Ctrl-+0 Grayscale Document
= 1 @ From Clipboard Color Document
4, From Blank Page Color Image
Assemble PDF Partfalio. .. Custom 3can..,
‘;_‘L‘ Export » .ﬂ‘l Merge Files into a Single POF... Configure Presets...

Select the correct device, click the checkbox for “Make PDF/A compliant”, and click OK:

Scanner; | Please select a device v‘

Presets: | Black & White Docurment v‘ [ Save ] [ Defaulks I
Input

Sides: | Both Sides - ‘

Color Mode: | Black and white £ ‘

Resolution; | 300 DPT £ ‘

Paper Sige: | Automatic ~ ‘

width: | Height:

DPrompt for scanning more pages
Dptimization

Texk Recognition and Metadata

[#]Make Searchable (Run GCR)

[] Add Metadata

To produce the PDF/A document, select “Create PDF”, “From scanner” again, and select the
type of document.
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If the scanner is not connected to your computer

Scan the document to create a PDF document and convert it to PDF/A. One method is
described at Creating PDF documents with Acrobat.

Hyperlinks in PDF/A Documents

When a document with active links is displayed, clicking a link will normally take the user to the
referenced document or site. Two notable exceptions are described below.

Masked Hyperlinks

Hyperlinks are commonly “masked,” meaning that the full address of the referenced file is not
written out; for example, clicking the word Brief may open a brief which was previously filed in
CM/ECF. An “unmasked” hyperlink has the full address visible to the user, such as
“https://ecf.dcd.uscourts.gov/doc1/04512244142".

Masked hyperlinks may or may not work in a PDF/A document, depending on how it was
created. Currently, masked hyperlinks are preserved in PDF/A documents produced by the
“Save As” method in Microsoft Word 2007 and 2010; the “PDFMaker” method in Microsoft
Word 2007; and OpenOffice 2.4 (“PDF Export”). With other production methods, such as
WordPerfect, the PDF/A document includes underlined words that appear to be links, but
clicking them has no effect. To avoid this potential problem, filers should use unmasked links in
their documents. This would also be helpful to anyone viewing a printed copy of the document
who needs to see a referenced item.

Adobe’s PDF/A View Mode

If version 9 of Adobe Reader or Acrobat is being used for display, links will not work in “PDF/A
View Mode” (the default mode). A user who wants to use the hyperlinks must disable “PDF/A
View Mode”, as shown below. Adobe reports that with Version 10 of the Adobe products (and
perhaps with a patch to Version 9), this disabling will not be necessary; hyperlinks will be active
in PDF/A View Mode.
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From the Edit menu, select “Preferences” and click the “Documents” category; select “Never”
in the PDF/A View Mode drop-down list:

Preferences |
Categaries: Open Settings
Documents ™ Restore last view settings when recpening dacuments
Full Sereen ¥ Open cross-document links in same window
Gengral

) V¥ allow layer state to be set by user information
Page Display

¥ allow documents ko hide the menu bar, toolbars, and window controls
30 & Multimedia
Accessibility
Acrobat.com
Forms
Identity
International Save Sethings
Internet
JavaScript
Measuring (20)
Measuring (30)
Measuring {Geo)
Multimedia (legacy)
Multimedia Trust {legacy) View documents in PDFA mode:
Reading
Search
Security
Security (Enhanced)
Speling
Tracker
Trust Manager
Units

Documents in recently used list: |5 ﬂ

¥ automatically save document changes to termporary File every: S minukes {1-99)

¥ Save &s optimizes For Fast \Weh Yiew

PDF[A Yiew Mode

Only For PDF/A documents
Cnly For PDFJA documents
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Frequently Asked Questions

What is PDF/A?
PDF/A is an International Standards Organization (ISO) standard document format. It is
a subset of the PDF standard which excludes those PDF features that give rise to
concerns about security and the ability to archive documents.

Why does the judiciary need to move to PDF/A for its CM/ECF documents?
To reduce security risks and to improve the ability to archive documents. Since its
inception in 1995, CM/ECF has required that documents be filed in PDF format. Over the
years, PDF has had many features added to it, and some of those features have created
security risks. Formal security audits have pointed out the vulnerability. PDF/A
eliminates those security risks and also enhances the ability to archive with the National
Archives and Records Administration (NARA).

When will the judiciary require that all documents filed in CM/ECF be in PDF/A format?
Currently, no deadline has been set nationally or by the Western District.

What does an attorney need to do to create PDF/A documents?
More than ninety commercial products, including word processors, can create PDF/A
documents. In most cases, users simply need to update the settings in those products to
make PDF/A the default format. A filer who now uses software that does not support
PDF/A will need to acquire a product that does; a free word processor can be
downloaded from OpenOffice.org.

How are hyperlinks in documents affected by the PDF/A requirement?
Many PDF writers create PDF/A documents with active (“clickable”) links. Other PDF
writers produce PDF/A documents with active links only if the links are unmasked (i.e.,
the link is a full URL and not a shorthand literal that represents the full URL).

Are there special considerations for using active links in PDF/A documents?
If Version 9 of Adobe Reader or Acrobat is being used to display a PDF/A document,
links will not work if the default “PDF/A View Mode” is in effect. A user who wants to use
the hyperlinks must disable “PDF/A View Mode”, as described in Hyperlinks in PDF/A
Documents. Adobe reports that with Version 10 of the Adobe products (and perhaps with
a patch to Version 9), this disabling will not be necessary; hyperlinks will be active in
PDF/A View Mode.

How can a user create a PDF/A from a scanned document?
Newer scanners (manufactured since 2005 or so) allow users to directly create a PDF/A.
Users with older scanners can use a conversion tool such as Acrobat 9 to convert

scanned documents to PDF/A. See Creating PDF/A from a scanned document.

Which PDF/A format should filers use: 1a or 1b?
PDF/A 1ais preferred; PDF/A 1b meets the minimum requirement. Users with the option
should select PDF/A 1a.

Page 13



How will the Appendix function be affected?
The Appendix created by CM/ECF will be in PDF/A format, and "live" links will be
preserved.

How does the PDF/A requirement affect data-enabled (“fillable”) forms, such as those
downloaded from the uscourts.gov web site?
Just as with PDF, fillable forms such as a bankruptcy petition or a credit counseling
certificate must be in PDF/A format before they are filed in CM/ECF. A PDF/A can be
created by “printing” from the browser - see Creating PDF/A document with Acrobat.

How does the PDF/A requirement affect users of StampPDF?
StampPDF documents are not in PDF/A format and must be converted to PDF/A with a
product such as Acrobat 9 Professional.

How does the PDF/A requirement affect Mac users?
Microsoft Word 2008 for Mac cannot create PDF/A documents, but can create PDF
documents which can be converted to PDF/A. Alternately, a Mac user can install and
use OpenOffice, which is available for free; see OpenOffice settings for PDF/A.
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